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The following set of slides documents how the second LifeMech
PanVentTM OS Emergency Use Ventilator was assembled. 

This is a baseline set of instructions as a starting point for assembly 
of the PanVentTM OS device

The part numbers in this slide deck coincide with those in an Excel 
BOM.  The use of both of the assembly instructions and the BOM v 
2.10 is critical to fully understand how to build and assemble the 
PanVentTM.
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Tools:

 Something to cut PVC with

o Circular saw

o Jigsaw

 Sander

 De-burring tool

 Calipers/precise measuring tool

 7/64” bit

 9/64” drill bit

 5/32” bit

 11/64” drill bit or slightly larger

 ½” bit

 #47 drill bit

 #55 drill bit

 #60ish drill bit

 150 grit sandpaper

 400 grit sandpaper

 Philips head screwdriver

 Permanent marker

 Scissors

 Mallet

 Laser cutter

 Teflon tape

 Small hammer

 X-Acto knife

 3M industrial strength double-sided tape

 Wire crimping tool

 Plastic bonder (PV-PN-223, and PV-PN-224)

 Glue (PV-PN- 204)

 Silicon adhesive (PV-PN-229)

 Multipurpose synthetic grease (PV-PN-215)

 Compass

 Superglue (PV-PN- 206)
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PanVent Sections:

1) PV-PN-A03 - Inspiratory limb
1A) PV-PN-A04 - Anti Asphyxia valve
1B) PV-PN-A05 - Overpressure valve
1C) PV-PN-000 - Orifice

2) PV-PN-A10 - Flow meter assembly
3) PV-PN-A02 - Expiratory limb

3A) PV-PN-A16 Modified Orbit Valve
3B) PV-PN-A15 - Solenoid wiring harness

4) PV-PN-A13 - Controller box
4A) PV-PN-A11 - small plenum
4B) PV-PN-A12 – large plenum

5) PV-PN-A14 - Plastic enclosure
5A) PV-PN-A06 – Pressure regulator assembly
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Pipes to cut per section:

Inspiratory Limb:
Expiratory Limb:

Diagram 
Label Type/Diam

Length 
needed 
per part 
(inch)

Qty:

4 PVC – ¾” 2.0" 3

8 CPVC – ¾” 5.0" 1

Flow Meter Assembly:

Diagram 
Label Type/Diam

Length 
needed 
per part 
(inch)

Qty:

7 PVC – ¾” 2.0" 1

9 CPVC – ¾” 9.5" 1

10 PVC – ¾” 3.5" 2

11 PVC – ¾” 5.5” 1

Diagram 
Label Type/Diam

Length 
needed per 
part (inch)

Qty:

2 CPVC – ¾” 2" 1

3
Delrin – see 

BOM 2.5" 1

6 CPVC – ¾" 1.5" 1

7 PVC – ¾” 5" 1
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Cutting the PVC sections:

My method: Recommended method: Alternative methods:
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Sand and De-bur ends of newly cut pipes:
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All pipes and part numbers:
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PV-PN-A04 – Anti Asphyxia valve – All parts

PV-PN-201

PV-PN-203 PV-PN-204

PV-PN-054

PV-PN-206
½” bit

7/64” bit

5/32” bit

150 grit 
sandpaper

400 grit 
sandpaper

De-burring tool

Phillips 
screwdriver Permanent 

marker
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PV-PN-A04 – Anti Asphyxia valve – STEP 1: cut a circle of diameter ~1.152 inches. 

= I HIGHLY RECOMMEND A STAMPING DIE (OR SOMETHING ELSE) IS USED TO CUT THESE CIRCLES.

ENSURE THERE IS A SMALL GAP ALL AROUND THE EDGE.

PV-PN-54

PV-PN-201

Silicone sheet is 1/16” thick.
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PV-PN-A04 – Anti Asphyxia valve – STEP 2: drill a ½” hole in the PVC plug.

= A DRILL PRESS WITH SOME SORT OF A CLAMP/JIG WOULD MAKE THIS MUCH EASIER AND OF HIGHER 
QUALITY.

EDGE OF HOLE IS AS CLOSE TO INNER WALL AS POSSIBLE

DRILL HOLE USING A ½” 
DRILL BIT AT A SLOW RPM.

PV-PN-201
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PV-PN-A04 – Anti Asphyxia valve – STEP 3: drill a 7/64” hole in the PVC plug.

= A DRILL PRESS WITH SOME SORT OF A CLAMP/JIG WOULD MAKE THIS MUCH EASIER.

EDGE OF HOLE IS AS CLOSE TO INNER WALL AS POSSIBLE

DRILL HOLE USING A 
7/64” DRILL BIT.

PV-PN-201
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PV-PN-A04 – Anti Asphyxia valve – STEP 4: sand and de-burr the plug
De-bur edges using tool. Perhaps a 
countersink tool could be used as an 
alternative.

Start with 150 grit 
sandpaper.  Move to 
400 grit sandpaper.  
Ensure bottom of plug 
is totally flat.
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PV-PN-A04 – Anti Asphyxia valve – STEP 5: drill hole in silicone flapper

= this operation could also be built into a stamping die (or another tool/operation).

Enlarge the hole with the 5/32 drill bit.

Place flapper on end 
of plug. Mark hole 
location on to the 
flapper from the 
opposite side. 

Drill hole starting with 
the 7/64” drill bit.

Hole should be roughly the size of 
the M3 screw.. Maybe a little smaller 
is OK.
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PV-PN-A04 – Anti Asphyxia valve – STEP 6: attach flapper

PV-PN-203
PV-PN-204

BAD:
Hole in flapper 
needs to be 
enlarged:

GOOD:
Hole in flapper is 
acceptable size:

Gap exists:

Flapper sits flat:
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PV-PN-A04 – Anti Asphyxia valve – STEP 7: test and inspect flapper

Ensure no glue 
accidently sealed the 
flapper shut
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PV-PN-A04 – Anti Asphyxia valve – STEP 8: check flapper function within “elbow”

Push AA valve into PVC 
elbow.

Flapper should be able to move freely and remain 
unobscured.
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PV-PN-A05 - Inspiratory limb – overpressure valve – all parts: 

5/32” bit

150 grit 
sandpaper

400 grit 
sandpaper

Permanent 
marker

PV-PN-052

PV-PN-051
PV-PN-055

PV-PN-057

PV-PN-054PV-PN-053

PV-PN-206
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PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 1: assemble 3D printed poppet 
base and cut stainless steel rod

PV-PN-261

PV-PN-055



August 28, 2020, slide 20 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 2: ensure 3D printed parts fit 
together - check threaded interface

PV-PN-052

Use sandpaper to 
remove material until 
parts fit together.

PV-PN-051



August 28, 2020, slide 21 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 3: ensure 3D printed parts fit 
together - ensure plastic shaft has a loose sliding fit. Remove material until possible.

Use sandpaper to 
remove material until 
parts fit together.

PV-PN-055

PV-PN-052

Drilling out ID (be VERY careful… the walls 
are thin)
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PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 4: cut out silicone face seal 
material

PV-PN-054

= I RECOMMEND A STAMPING DIE (OR SOMETHING ELSE) IS USED TO CUT THESE CIRCLES.
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PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 5: use superglue to attach the 
sealing surface to the bottom of the poppet base.

Use sandpaper to lightly 
rough up bottom surface of 
poppet.

Apply superglue to the 
bottom of the poppet.

Stick the poppet to the 
silicone sealing surface and 
hold gently for 20 seconds.

PV-PN-206
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PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 6: push O-ring into groove

PV-PN-053

Push O-ring into groove. 

Remove enough material to 
allow O ring to sit flush.

BAD:
Remove more 
material.

GOOD:
O-ring groove is 
an acceptable 
size.

Small 
bumps on 
O-ring

No bumps on O-ring

BAD:
Remove more 
material.

large 
bumps on 
O-ring

O ring with good fit.
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PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 7: place spring in assembly.

PV-PN-057
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PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 8: place poppet on top of spring
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PV-PN-A05 - Inspiratory limb – overpressure valve – STEP 9: place OPR base on top of 
poppet base

Screw parts together carefully.
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PV-PN-000 – orifice plate – STEP 1: use laser cutter to cut out a circle

= There are multiple other ways to make this part. This part has successfully been made from Delrin on a lathe.

AS CUT = 25.92mm

1/8” or 3mm acrylic can 
be used.  This one is a 
tiny bit thinner at 2.91mm
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PV-PN-000 – orifice plate – STEP 2: test fit orifice plate in ¾” PVC tee

Orifice should rest on this ledge.  If PVC 
fitting does not have this ledge, create 
one with a 1/8” section of ¾” PVC pipe 
pressed in first. Note that there is the 
possibility some PVC fittings won’t have 
these nice ledges.  If so, use an 1/8” thin 
piece of pipe to create that ledge. 
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PV-PN-000 – orifice plate – STEP 3: using a #55 drill bit, create a hole in the center

#55 drill bit
(0.052 in)
(1.3208 mm)
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PV-PN-A06 – Pressure regulator – STEP 1: install NPT plug

NOTE: the flow direction 
arrow should point to the 
port you are plugging. PV-PN-227PV-PN-007

PV-PN-015
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PV-PN-A06 – Pressure regulator – STEP 2: install NPT gauge

PV-PN-014

Wrap each of the threaded 
portions with Teflon tape. 
Two to three times around.

Wrap 
clockwise.
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PV-PN-A06 – Pressure regulator – STEP 3: install NPT fitting

PV-PN-095
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PV-PN-A06 – Pressure regulator – STEP 4: install second NPT fitting

PV-PN-013
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PV-PN-A03 – Pressure regulator– STEP 5: cut supply line out of ¼” tubing.

PV-PN-096
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PV-PN-A03 – Inspiratory limb – STEP 1: attach connectors to the end of the valve wires

PV-PN-230

PV-PN-020
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PV-PN-A03 – Inspiratory limb – STEP 2: screw in NPT adapter fitting

PV-PN-010

Wrap 
clockwise.
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PV-PN-A03 – Inspiratory limb – STEP 3: screw in NPT push-to-connect “Y” fitting

PV-PN-008
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PV-PN-A03 – Inspiratory limb – STEP 4: orifice related parts shown here

#60-ish drill bit 9/64 drill bit

PV-PN-001 PV-PN-018

PV-PN-004PV-PN-000 PV-PN-002
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PV-PN-A03 – Inspiratory limb – STEP 5: place orifice in fitting and O-ring on top.

PV-PN-000

PV-PN-018

O-ring should sit flat on 
orifice plate
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PV-PN-A03 – Inspiratory limb – STEP 6: install PVC tube 

PV-PN-004 PV-PN-229
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PV-PN-A03 – Inspiratory limb – STEP 7: mark and cut guide hole in PVC connection.

#60-ish drill bit
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PV-PN-A03 – Inspiratory limb – STEP 8: using guide hole, drill out actual hole.

9/64 drill bit
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PV-PN-A03 – Inspiratory limb – STEP 9: screw in bolt to lock two parts together

PV-PN-228
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PV-PN-A03 – Inspiratory limb – STEP 10: glue and install PVC fitting

PV-PN-002
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PV-PN-A03 – Inspiratory limb – STEP 11: mark and drill second guide hole

#60-ish drill bit
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PV-PN-A03 – Inspiratory limb – STEP 12: using guide hole drill the actual hole.

9/64 drill bit
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PV-PN-A03 – Inspiratory limb – STEP 13: install second screw to pin two parts together

PV-PN-228



August 28, 2020, slide 49 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-A03 – Inspiratory limb – STEP 14: attach Orbit valve. 

Wrap the threaded portion 
with enough Teflon tape.Wrap 

clockwise.
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PV-PN-A03 – Inspiratory limb – STEP 15: add pipe to assembly

Push and hold all parts together for 
a few minutes to make sure they 
don’t try and slide apart.  (the 
silicone adhesive acts as a 
lubricant and the PVC parts are 
tapered.)

Apply a blob of silicone adhesive to 
each end of the PVC tube. Smear the 
adhesive blobs to around the 
circumference to create a thin but 
uniform layer.

Apply a blob of silicone adhesive to the 
end of the CPVC tube. Smear the 
adhesive blobs to around the 
circumference to create a thin but 
uniform layer.

PV-PN-098
PV-PN-006

PV-PN-004
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PV-PN-A03 – Inspiratory limb – STEP 16: add more pipe and fitting to assembly

Push and hold all parts together for 
a few minutes to make sure they 
don’t try and slide apart.  (the 
silicone adhesive acts as a 
lubricant and the PVC parts are 
tapered.)

Apply a blob of silicone adhesive to the 
end of the CPVC tube. Smear the 
adhesive blobs to around the 
circumference to create a thin but 
uniform layer.

PV-PN-003

PV-PN-004

PV-PN-229
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PV-PN-A03 – Inspiratory limb – STEP 17: install anti asphyxia valve

Push and hold all parts together for 
a few minutes to make sure they 
don’t try and slide apart.  (the 
silicone adhesive acts as a 
lubricant and the PVC parts are 
tapered.)

PV-PN-A04

Ensure the AAV is pointing downwards, gravity ensures it remains 
closed when it is not activated.

Apply a blob of silicone adhesive 
to the end of the PVC plug. 
Smear the adhesive blobs to 
around the circumference to 
create a thin but uniform layer.

Push and hold all parts together for a few minutes to make 
sure they don’t try and slide apart.  (the silicone adhesive 
acts as a lubricant and the PVC parts are tapered.)

Apply a blob of silicone adhesive 
to the end of the PVC plug. 
Smear the adhesive blobs to 
around the circumference to 
create a thin but uniform layer.

PV-PN-229

PV-PN-229
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PV-PN-A03 – Inspiratory limb – STEP 18: install OPR valve

Push and hold all parts together for 
a few minutes to make sure they 
don’t try and slide apart.  (the 
silicone adhesive acts as a 
lubricant and the PVC parts are 
tapered.)

Apply a blob of silicone adhesive to the 
end of the CPVC tube. Smear the 
adhesive blobs to around the 
circumference to create a thin but 
uniform layer.

PV-PN-A05
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PV-PN-A03 – Inspiratory limb – STEP 19: replace cap on OPR valve

Re-thread on the cap for the overpressure 
valve.

Overpressure valve installed
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PV-PN-A03 – Inspiratory limb – STEP 20: measure and cut tubes and push into fittings

PV-PN-231

PV-PN-016
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PV-PN-A10 – flow meter assembly– all parts:

PV-PN-011

#47 drill bit

PV-PN-026

PV-PN-027

PV-PN-026

PV-PN-025

PV-PN-006

PV-PN-024 PV-PN-029PV-PN-029

PV-PN-206 PV-PN-229
Permanent 
marker.

Small 
hammer

#60-ish drill bit
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PV-PN-029

Tip: You will use qty: 8 of these in each 
ventilator assembly.  Feel free to make all of 
them at once.
Qty: 6 will be used with plenums
Qty: 2 will be used in the flow meter assembly

PV-PN-A10 – flow meter assembly– STEP 1: square off end of brass tube stock
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Measure and mark a length of 1 
inch.

Cut brass tubing to 1” length

PV-PN-A10 – flow meter assembly– STEP 2: measure and cut brass tube section
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Tip may have a big bur on the end. Very lightly bevel the 
corners of the brass tube.

Use cutoff wheel carefully or use 
sandpaper to flatten and square the 
end of the tube.

PV-PN-A10 – flow meter assembly– STEP 3: clean up, square off, and remove burrs on cut.
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PV-PN-A10 – flow meter assembly– STEP 4: remove burrs on ID of tube.



August 28, 2020, slide 61 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-027

#47 drill bit

PV-PN-A10 – flow meter assembly– STEP 5: measure and drill pilot hole
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#47 drill bit

PV-PN-A10 – flow meter assembly– STEP 6: using pilot hole, drill actual hole.
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Tip of brass tube should be 
in the center of the Delrin 
tube.

PV-PN-029

PV-PN-A10 – flow meter assembly– STEP 7: carefully tap brass tube into pipe
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PV-PN-206

PV-PN-A10 – flow meter assembly– STEP 8: add glue to base of the tube
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#60ish drill bit

PV-PN-210

PV-PN-A10 – flow meter assembly– STEP 9: measure and drill pilot hole
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#47 drill bit

PV-PN-A10 – flow meter assembly– STEP 10: using pilot hole, drill actual hole
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PV-PN-029

Tip of brass tube should be 
in the center of the PVC 
tube.

PV-PN-A10 – flow meter assembly– STEP 11: gently tap brass tube into PVC pipe.



August 28, 2020, slide 68 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-206

PV-PN-A10 – flow meter assembly– STEP 12: add glue to base of brass tube.
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Smear the adhesive blobs to 
around the circumference to 
create a thin but uniform 
layer.

Apply a blob of silicone 
adhesive to each side of the 
Delrin tube.

Push CPVC fittings on each 
end of the Delrin tube.

Use a clamp to ensure the 
CPVC parts don’t “walk” off 
due to the taper. I have seen 
this happen.  Perhaps clamp 
it for 5 or 10 minutes.

PV-PN-229

PV-PN-A10 – flow meter assembly– STEP 13: glue and push fittings over tube.
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Push CPVC tube into CPVC 
fitting

Apply a blob of silicone adhesive to 
the end of the CPVC tube. Smear the 
adhesive to create a thin but uniform 
layer around the tube.

Use a clamp to ensure the parts don’t 
“walk” off due to the taper. I have seen this 
happen.  Perhaps clamp it for 5 or 10 
minutes.

Apply a blob of silicone adhesive to 
the ends of the CPVC tube. Smear 
the adhesive to create a thin but 
uniform layer around the tube.

Push fittings on to newly siliconed
tube.

PV-PN-229

PV-PN-A10 – flow meter assembly– STEP 14: add more fittings to assembly
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Push CPVC tube into CPVC 
fitting

Apply a blob of silicone adhesive to 
the end of the CPVC tube. Smear the 
adhesive to create a thin but uniform 
layer around the tube.

Ensure the two brass tubes are 
parallel to each other.

PV-PN-229

PV-PN-A10 – flow meter assembly– STEP 15: add tube to assembly
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Each connection that had silicone adhesive added 
to it was marked with a “G”.  This is just as a 
reminder.

Hold parts together to ensure the parts don’t “walk” off 
due to the tapers. I have seen this happen.  Perhaps hold 
it for a few minutes.  A clamp would be easier.

PV-PN-A10 – flow meter assembly– STEP 16: push on parts to ensure they stay put.
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11/64 or slightly 
larger drill bit

PV-PN-020PV-PN-216 PV-PN-215 X-Acto knife

400 grit 
sandpaper

Permanent 
Marker

NOTE: this part comes as long uncut stock.

PV-PN-217

Expiratory Orbit Jartop valve modification – all parts 
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Expiratory Orbit Jartop valve modification – STEP 1: measure and cut spacer stock 

PV-PN-217
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Expiratory Orbit Jartop valve modification – STEP 2: sand to size (0.280 in long) 
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Expiratory Orbit Jartop valve modification – STEP 3: if sanding didn’t, de-burr ID of spacer

Use these tools to lightly deburr outer edge 
of ID of spacer.
NOTE: do NOT drill center of hole to be 
larger. 
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Expiratory Orbit Jartop valve modification – STEP 4: unbox and remove bleed screw

Remove bleed screw

PV-PN-020
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Expiratory Orbit Jartop valve modification – STEP 5: unscrew “jar top” and remove lid.

NOTE: the spring is compressed inside of 
here and may try to pop open once the lid is 
unscrewed.

NOTE: the spring is now free
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Expiratory Orbit Jartop valve modification – STEP 6: install spacer on the stainless post.

Spacer should slide freely all the way to the 
bottom of the post.

NOTE: if the black ring 
accidently comes out, above 
is can the correct orientation 
for reinstallation.
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Expiratory Orbit Jartop valve modification – STEP 7: apply a small amount of synthetic 
grease to the post above the spacer.
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Expiratory Orbit Jartop valve modification – STEP 8: slide an O-ring down the post and 
apply a small amount of additional grease on top of it. Repeat with a second O-ring.
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Expiratory Orbit Jartop valve modification – STEP 9: re-install the spring in its new location 
BENEATH the rubber diaphragm. 



August 28, 2020, slide 83 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

Expiratory Orbit Jartop valve modification – STEP 10: next, place the diaphragm ON TOP of 
the spring.



August 28, 2020, slide 84 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

Expiratory Orbit Jartop valve modification – STEP 11: carefully compress the sandwich of 
the components and re-install the jar top ring to hold it all together. 
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Expiratory Orbit Jartop valve modification – STEP 12: mark this valve to clearly distinguish 
it from the other Orbit valve in the inspiratory limb.
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PV-PN-A10 – expiratory limb – all parts:

PV-PN-036 PV-PN-034 PV-PN-002
PV-PN-011 PV-PN-006

PV-PN-033
PV-PN-002

PV-PN-034

PV-PN-036 PV-PN-035 PV-PN-006 PV-PN-037
PV-PN-A10

PV-PN-A16

PV-PN-227
PV-PN-030

PV-PN-223
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Ensure the flow direction is 
oriented as show.

Wrap each of the threaded 
portions with Teflon tape. 
Two to three times around.

Wrap 
clockwise.

PV-PN-A16

PV-PN-002PV-PN-002

PV-PN-227

PV-PN-A10 – expiratory limb – STEP 1: tape and screw fittings into valve body
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Apply a blob of silicone adhesive each 
end of the related tubes. Smear the 
adhesive blobs around the 
circumference to create a thin but 
uniform layer.

Push tubes and fittings together Hold parts together for a minute or two to keep 
them from separating due to the PVC tapers.

PV-PN-A10 – expiratory limb – STEP 2: glue and push fittings together
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Apply a blob of silicone adhesive each 
end of the related tubes. Smear the 
adhesive blobs around the 
circumference to create a thin but 
uniform layer.

Hold parts together for a minute or two to keep 
them from separating due to the PVC tapers.

PV-PN-A10 – expiratory limb – STEP 3: one step at a time, glue and attach fittings and pipes
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Apply a blob of silicone adhesive each 
end of the related tubes. Smear the 
adhesive blobs around the 
circumference to create a thin but 
uniform layer.

Push filter into fitting. Hold parts together for 5 
to 10 minutes using a rubber band. 

PV-PN-A10 – expiratory limb – STEP 4: glue and install filter
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Using a set of pliers I “threaded” this 
tube into the solenoid port. 

Remove the solenoid temporarily.

PV-PN-030

PV-PN-A10 – expiratory limb – STEP 5: install tube into valve
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Using a set of pliers I “threaded” this 
tube into the solenoid port. 

Remove the solenoid temporarily.

PV-PN-A10 – expiratory limb – STEP 6: secure tube in valve body using epoxy

PV-PN-223



August 28, 2020, slide 93 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-A15 – solenoid wiring harness – all parts: build wiring harness.  

PV-PN-232
PV-PN-241

PV-PN-239

PV-PN-234PV-PN-233

PV-PN-241

PV-PN-240

PV-PN-240

PV-PN-207

PV-PN-207

PV-PN-022

PV-PN-227

PV-PN-234

PV-PN-236

PV-PN-236

PV-PN-236

NOTE:
Each “arm” should be roughly 2 feet long.
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Rotate the metal portion of the solenoid 
valve as shown.  (It should only be able 
to do a full 90 degree rotation in one 
direction.)

Note the “P” here:

Note the “A” here:

Not used.

PV-PN-022

PV-PN-A15 – solenoid wiring harness – STEP 1: twist valve to gain access to ports
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Push-to-connect fittings installed:

Wrap each of the NPT 
threads with Teflon tape.  I 
only needed a little over 1 
turn here… there was 
already sealant on the 
threads. 

Wrap 
clockwise.

PV-PN-23

PV-PN-227

PV-PN-A15 – solenoid wiring harness – STEP 2: tape and attach fittings



August 28, 2020, slide 96 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-A15 – solenoid wiring harness – STEP 3: remove terminal block from valve block

Unscrew the screw in the 
plastic housing.

Remove screw Plastic housing should pull 
off.. It is possible the black 
terminal lug section could 
come off with it.

Pull off the black terminal lug section.
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PV-PN-A15 – solenoid wiring harness – STEP 4: push wires through plastic cap.
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PV-PN-A15 – solenoid wiring harness – STEP 5: secure wires in terminals

BLACK wire connects to “2”
RED wire connects to “1”NOTE: when wired and 

reassembled correctly, this 
LED should flash RED
whenever the valve is 
actuated.

Remove insulation on wires 
and clamp down with the 
screw terminals.
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PV-PN-A15 – solenoid wiring harness – STEP 6: re-install terminal block

Push the plastic covered 
terminal block back onto the 
valve body. Re-tighten screw.
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PV-PN-A15 – solenoid wiring harness – all parts: connect appropriate wires to connector

pin 1 – RED – green inspiratory Orbit valve
pin 2 – RED - pneumatic solenoid valve (expiratory) 
pin 3 – BLACK – ground from inspiratory Orbit valve
pin 4 – BLACK – ground from pneumatic solenoid valve 
(expiratory)

Disassemble radio plug to 
attach wires.  Use the guide 
on this page.

Add heat shrink where the 
fuse holders attached to the 
red wires.

These fuse holders come 
with 30A fuses.  You must 
replace those with the 2A 
fuses.

PV-PN-233



August 28, 2020, slide 101 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-A11 – small plenum – all parts:

PV-PN-211

PV-PN-210

PV-PN-204
PV-PN-029

#47 drill bit

NOTE: you will be making qty: 2 of these per device.
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PV-PN-A11 – small plenum – STEP 1: drill holes in the center of the PVC plug and cap.

PV-PN-210

#47 drill bit

#47 drill bit

PV-PN-211

De-burr backside of 
holes.
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PV-PN-A11 – small plenum – STEP 2: flatten/deburr the end of the brass tube stock.

PV-PN-029

Tip: You will use qty: 8 of these in each 
ventilator assembly.  Feel free to make all of 
them at once.
Qty: 6 will be used with plenums
Qty: 2 will be used in the flow meter assembly
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PV-PN-A11 – small plenum – STEP 3: cut brass tubing to length

Measure and mark a length of 1 
inch.

Cut brass tubing to 1” length

Reminder: You will use qty: 8 of 
these in each ventilator assembly.  
Feel free to make all of them at 
once. 
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PV-PN-A11 – small plenum – STEP 4: remove burrs and square end of newly cut tube

Tip may have a big bur on the end. Very lightly bevel the 
corners of the brass tube.

Use cutoff wheel carefully or use 
sandpaper to flatten and square the 
end of the tube.
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PV-PN-A11 – small plenum – STEP 5: deburr the inside diameter of the ends of the brass 
tube
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PV-PN-A11 – small plenum – STEP 6: push brass tubes into PVC fittings

Try and make the end of the brass 
tube flush with the inside wall of the 
fittings.
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PV-PN-A11 – small plenum – STEP 7: add glue to base of brass tubes

Apply super glue to the 
base of the brass tubes.
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PV-PN-A11 – small plenum – STEP 8: add silicone adhesive and push fittings together
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PV-PN-A12 – large Plenum – all parts:

PV-PN-213

PV-PN-212

PV-PN-204

PV-PN-029

#47 drill bit
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PV-PN-212

#47 drill bit

#47 drill bit

PV-PN-211

De-burr backside (out of view) of these two holes.

PV-PN-A12 – large Plenum – STEP 1: drill holes in the center of the PVC plug and cap.
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PV-PN-A12 – large Plenum – STEP 2: flatten/deburr the end of the brass tube stock.

PV-PN-029
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PV-PN-A12 – large Plenum – STEP 3: cut brass tubing to length

Measure and mark a length of 1 
inch.

Cut brass tubing to 1” length
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PV-PN-A12 – large Plenum – STEP 4: remove burrs and square end of newly cut tube

Tip may have a big bur on the end. Very lightly bevel the 
corners of the brass tube.

Use cutoff wheel carefully or use 
sandpaper to flatten and square the 
end of the tube.
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PV-PN-A12 – large Plenum – STEP 5: deburr the inside diameter of the ends of the brass 
tube
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PV-PN-A12 – large Plenum – STEP 6: push brass tubes into fittings

Try and make the end of the brass 
tube flush with the inside wall of the 
fittings.
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PV-PN-A12 – large Plenum – STEP 7: put super glue on base of brass tubes.

Apply super glue to the 
base of the brass tubes.
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PV-PN-A12 – large Plenum – STEP 8: add silicone adhesive and push fittings together

Push the two fittings together as far as 
possible. See example to the right.  You 
should see a little bead of silicone adhesive 
appear at the joint when you push them 
together.



August 28, 2020, slide 119 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

PV-PN-209 – controller box lid modification – STEP 1: find jig and clamp jig to box lid.

PV-PN-209

NOTE: jig is made of 
3mm acrylic and was 
cut on a laser cutter.NOTE: V3 was 

used when I 
made it

NOTE: V4 is recommended 
to make the countersinks 
easier.

PV-PN-T201

NOTE: CANTEX box was used here.  
Carlon box is what Home Depot has 
sometimes. It unknown if this will work or 
not. 
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PV-PN-209 – controller box lid modification – STEP 2: countersink and drill out all the 
holes. Mark where the display “window” needs to be

Using the V3 jig, I marked the center of each of the 
four button holes.  A 2.0mm drill was used to make a 
starter hole for the counterbore tool.  I used a 
counterbore/wood drill to create counterbores 
between 2.0 and 2.5mm deep.

Using the V4 jig, there is now simply a 2.0mm hole 
that can be used as a starter hole for the counterbore 
drill.

After counterbores are drilled, use a 0.5” drill bit to 
carefully drill through to create the button holes.

I used an X-acto knife to scribe the proper location of 
the window into the back of the lid.
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PV-PN-209 – controller box lid modification – STEP 3: cut display window.
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PV-PN-209 – controller box lid modification – STEP 4: prepare lid for buttons

Use a de-burring tool to remove material and create a chamfer on the button 
holes.  This will allow the buttons to sit flush with the front of the panel.

PV-PN-209
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PV-PN-209 – controller box base modification – STEP 1: drill vent holes

Holes are to be of 1/8” diameter and angled upward at a 45 degree angle.  
Water should not collect in box if dripped from above.
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PV-PN-214 – acrylic display window – build this for controller box build 
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Controller box assembly – STEP 1: add standoffs, display window, buttons, audio jack & 
power jack, and solder wires to buttons

= WE RECOMMEND SOURCING BUTTONS WITH SLIGHTLY HIGHER QUALITY.

NOTE: hole locations 
were defined using a laser 
cut jig. 

12x Washer

12x 12mm screw

4x 6mm standoff

4x 12mm standoff

4x 15mm standoff

2. Install display window to the top of the 
box. Use 4x 12mm screws with washer, 
pass them through from top and secure 
them with 4x 6mm standoffs (blue) at the 
bottom. Do not overtighten the standoff.

3. Install four buttons from the top side and 
secure them with washer and hex nut on the 
bottom side. Solder a 6-7 inch long wire to the 
left terminal and daisy-chain ground (black) 
wire to the right. You should have 5 wires (4 + 
1 black) with one end open.

4. Install the audio jack and power jack 
from the top side and secure them with the 
washer and the hex nut at the bottom.

1. Install 4x 12 mm standoffs 
(green) and 4x 15 mm standoffs 
(red) to the lid. Insert 4x 12mm 
screws with washer from the top 
side to secure these standoffs at the 
bottom of the lid. Do not overtighten

PV-PN-214

PV-PN-301

PV-PN-303PV-PN-304
PV-PN-302

PV-PN-307
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Controller box assembly – STEP 2: prepare transducer board, basic assembly

= WE RECOMMEND COMBINING THE TRANSDUCER BOARD AND THE CONTROLLER BOARD INTO ONE DESIGN TO 
SIGNIFICANTLY REDUCE ASSEMBLY TIME

Add photo of controller 
box top with buttons 
installed.

1. Obtain bare Transducer PCB board from 
the University of Florida team, or fab your 
own board

2. Assemble the components shown as per the 
transducer board parts listed in the BOM 
spreadsheet, except for the Green & Red LEDs. We 
will cover those in a later slide

PV-PN-305
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Controller box assembly – STEP 3: prepare BMP280 sensor (airway pressure) for 
installation on the transducer board – all parts:

PV-PN-222 PV-PN-223

highly recommend sourcing different fittings if this goes to high volume manufacturing.

Vacuum Connector Assortment

400 grit sandpaper

PV-PN-309 PV-PN-308

Adafruit BMP280 sensor 
and 7-pin header

Epoxy glue¼” x 1/8” connector
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Controller box assembly – STEP 4: solder header, sand fitting, add a small amount of                                
a                     adhesive and place fitting over pressure sensor

2. Sand base of fitting to create a nice flat 
surface on the larger end.

PV-PN-223

3. Mix a small amount of the two part 
epoxy and apply a very small amount 
around the bottom of the fitting.  Be 
careful not to get any on the ID of 
fitting.

4. This is the 
pressure sensor.  
Be VERY careful 
while placing the 
fitting over the 
sensor, not to get 
any epoxy on this 
component.

5. Cover 
pressure 
sensor 
entirely 
and WAIT 
for Epoxy 
to fully 
cure

1. Solder a 7-pin header to the Adafruit BMP280 
sensor board. The header pins stick out on the board 
from the opposite side of the BMP280 sensor.

Sensor side Opposite side

PV-PN-308
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Wait for epoxy to 
fully cure

2. Mix another larger 
amount of the two part 
adhesive. 

3. Add adhesive until entire connection from fitting to 
board is covered and sealed.  No air should be able to 
get to the sensor unless it comes from inside the fitting.

Controller box assembly – STEP 5: build up a strengthening adhesive structure around 
base of fitting.

1. Ensure the epoxy is 
fully cured. 

PV-PN-223

PV-PN-308
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Controller box assembly – STEP 6: prepare BMP280 (ambient pressure) sensor & Allsensors
(diff pressure) DLHR-F50D-E1BD – all parts:

highly recommend sourcing different fittings if this goes to high volume manufacturing.

Ribbon cable bundle Prototype Circuit board

JST-XH Connector Kit with Crimping tool

3M industrial strength double-sided tape

PV-PN-313

PV-PN-312PV-PN-311

PV-PN-310
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Controller box assembly – STEP 7: prepare BMP280 sensor (ambient pressure) for 
installation on the transducer board

1. Solder a 4-wire 
bundle to VIN, GND, 
SCK and SDI 
terminals on the 
same side as the 
BMP280 sensor

2. Solder a jumper 
wire between SDO 
and GND terminals 
on the other side of 
BMP280 sensor. This 
sets the address of 
this BMP280 sensor 
to value 0x76 (hex) 
on the I2C bus

BMP280 
sensor 

PV-PN-308

PV-PN-311
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Controller box assembly – STEP 8: prepare Allsensors DLHR-F50D-E1BD (diff pressure) 
sensor for installation on the transducer board

1. Cut the 20-pin protoboard to an approx. 1”x 1.5” 
size such that 8 pins are available to solder the 
Allsensors DLHR-F50D sensor to the protoboard.

2. Carefully solder a DLHR-F50D sensor to the cut 
protoboard and solder one end of a 5-inch 4-wire 
bundle.  

3. Select a 4-pin XH-4Y JST female socket from the JST connector kit. Using 4x 
female pin connectors and crimping tool, crimp/attach the other end of the 5-inch 4-
wire bundle to the XH-4Y female socket. Ensure pins labeled Vs, Gnd,, SCL/SCLK, 
SDA/MOSI on the DHLR-F50D sensor, align with pins labeled VIN, GND, SCL, SDA on 
the 4-pin male connector on the Transducer board respectively (see Step 4)

Pin 4 

Pin 1 

4. Select a 4-pin XH-4A JST male plug from the JST 
connector kit or an equivalent right-angled male plug. Solder 
the 4 pins of the plug to the bottom side of the 4-pin 
BMP280 (ambient sensor) board location marked “280” on 
the transducer board.

4-pin Right-angled 
male plug

PV-PN-312

PV-PN-314
PV-PN-310

PV-PN-305

PV-PN-311
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Controller box assembly – STEP 9: install the two BMP280 sensors to the transducer board

2. Solder the second BMP280 (ambient pressure) sensor to the 4-
pin terminal in the space marked ‘280’ towards the upper left. 
Ensure pins VIN, GND, SCK, SDI on BMP280 connect with pins 
labeled VIN, GND, SCL, SDA on the Transducer board 
respectively. Please ensure that the BMP280 sensor is on the 
bottom side (shown above is incorrect, it should not be on 
top)

1. Stick a double-sided tape on the bottom side and 
then insert header on the first BMP280 (airway 
pressure) sensor into the ‘Adafruit 280’ terminals, 
solder the pins and cut the excess length

3. Flip the second BMP280 sensor board and glue it with 
a glue gun to the transducer board, so it sits next to the 
first BMP280 sensor board as shown above. Please 
ensure that the BMP280 sensor is on the TOP side of 
the board, after it is flipped, before gluing.

BMP280 
sensor 



August 28, 2020, slide 134 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

Controller box assembly – STEP 10: install the Allsensors DLHR-F50D-E1BD on to the 
transducer board

1. Use a double-sided tape to attach the protoboard 
with Allsensors DLHR-50D sensor to the transducer 
board, right on top of the label ‘Transducer board’. 
Orient the 4-wire bundle and the two ports from the 
sensor as shown.

2. Bend the 4-wire bundle and insert the male plug 
into the female socket and push it until it locks. Fold 
the excess length of the 4-wire bundle, if any and 
secure in place with a double-sided tape. 
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Controller box assembly – STEP 11: prepare controller board, basic assembly changes

REMOVE 

REPLACE 
this 16-pin female header 

WITH
this 16-pin right-angle 
male header

PV-PN-315

PV-PN-316
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Controller box assembly – STEP 12: prepare display, ribbon cable for assembly

1. Solder a 16-pin right-
angle header to the display

2. Build a 16-pin 10-inch 
long flat ribbon cable female 
to female, from a flat 
rainbow cable and 4x 8-pin 
crimp connector housing 
female. 

PV-PN-316

PV-PN-316

PV-PN-311 PV-PN-318
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Controller box assembly – STEP 13: solder battery connectors, power jack wires, supply
cables to Controller board and red & green LEDs

1. Battery connectors: Solder two 
~15-inch long #16-#18 stranded 
wires, a RED wire to the positive 
terminal/pad marked ‘BATT’ and a 
BLACK wire to the negative 
terminal/pad marked ‘GND’. Note 
that the negative connector 
shares the GND pad with the 
power jack negative wire in the 
diagram. Connect the other end to 
female, insulated, crimp terminals 
of matching colors, if available.

2. Power jack wires: Solder two 
~9-inch long #16-#18 stranded 
wires, a RED wire to the positive 
terminal/pad marked ‘17V’ and a 
BLACK wire to the terminal/pad 
marked ‘GND’, shared with 
battery negative wire. Leave the 
other end open, we will cover it in 
a later slide.

3. Controller board power: Solder 
two ~9-inch long #16-#18 
stranded wires, a RED wire 
connecting terminal/pad marked 
“PWR OUT” on transducer board 
to positive terminal/pad for DC-
power (J5) and a BLACK wire to 
the negative terminal/pad, as 
shown

4. Extend the leads of a red LED 
and a green LED to approx. 6 
inches long, solder red LED to 
pads at D3, marked ‘ON BATT’ 
and solder green LED to pads at 
D2, marked ‘AC PWR’. Please 
pay attention to the polarity for 
these diodes, else LEDs won’t 
light up.

PV-PN-319

PV-PN-320
PV-PN-321
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Controller box assembly – STEP 14: build a voltage divider with resistors, install Arduino 
Nano, solder wires to solenoid terminals, solder jumper to A7

1. Build a voltage divider with a 10K and a 3.3K 
resistors between the positive and negative 
terminals of the supply voltage. Solder a brown 
wire at Vout in diagram and run it to pin 4 of 
Extension port J10. 

3.3K Ω 10K Ω

J10 – Pin 4
3. Solder the brown wire from step 1 to Pin 4 of Extension port J10, as shown. The goal 
is to build a fuel gauge for the 12V battery, which is approx. 13.2V when fully charged 
and drains to below 11.0V when we should alarm. The Vout is tied to A7 analog pin 
on Arduino, will be in range 0-3.3V and will work as a battery fuel gauge.

3. Solder four wires (two pairs) approx. 3-4 inches long from Solenoid_A
and Solenoid_B terminals. The BLACK wires connect to ground 
terminals and can be shorted, the WHITE wire to Solenoid_A positive 
terminal and the RED wire to Solenoid_B positive terminal.

2. Install Arduino Nano into the 30-pin (15x2) 
header marked A1, by aligning pin 1, gently 
pushing it down all the way, careful not to bend 
any pins.

PV-PN-319

PV-PN-322

PV-PN-323
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Controller box assembly – STEP 15: install controller board to the lid of the control box
and solder wires to buttons and audio jack

1. Align the 4 through-holes on the controller 
board on top of the 4x 12mm standoffs (installed 
in step 1) and gently insert. Use 4x hex nuts from 
M2 standoff set (BOM) and hand-tighten to 
secure the board in place.

2. Solder the four wires (yellow, green, red, blue) 
from the buttons on the lid to the corresponding 
button terminal on the controller board. Please be 
careful on the order. Finally solder the common 
black wire to one of the button ground terminals 
on the controller board.

3. Solder the four wires for solenoid control from 
the controller board to the Audio jack as follows:

Pin 1 – Solenoid A positive – White 
Pin 2 – Solenoid B positive – Red
Pin 3 & 4 – Ground - Black
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Controller box assembly – STEP 16: install transducer board to the lid of the control box,
insert LEDs and solder wires to power jack

1. Align the 4 through-holes on the transducer  
board on top of the 4x 15mm standoffs (installed 
in step 1) and gently insert the board onto the 
standoffs. Use 4x hex nuts from M2 standoff set 
(BOM) and hand-tighten to secure the board in 
place.

2. Insert the green LED into the hole next to the 
power jack. Insert the red LED into the hole next 
to the audio jack. Secure any excess length of 
the cables tucked under the board or tie with a 
cable tie.

3. Solder the red wire to the center or positive 
terminal and the black wire to the negative or 
shield terminal of the power jack.
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Controller box assembly – STEP 17: install 20x4 display to the lid of the control box, and 
connect the 16-pin cable to control board

1. Align the 4 through-holes on the display on top 
of the 4x 6mm standoffs (installed in step 1) and 
gently insert the display onto the standoffs. Use 
4x hex nuts from M2 standoff set (BOM) and 
hand-tighten to secure the display in place. The 
display LCD should be visible and sit just below 
the window on the front side of the lid.

2. Carefully connect the 16-pin flat ribbon cable 
between the 16-pin headers on the controller 
board, followed by the display. Please ensure 
that pin-1 on controller board aligns with pin 1 on 
the display. Please note that the cable needs two 
folds or bends, a U-fold and a 45-degree bend for 
the alignment (see step 12 slide). Use a 2-sided 
tape to secure the folds and the cable on the 
display board.

Pin-1

3. Front view of the display with bezel. Should be 
perfectly aligned and visible through the window.

Potentiometer to adjust contrast of the 
LED display, by turning screw clockwise or 
counter clockwise
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Controller box assembly – STEP 18: install a buzzer/speaker and I2C cable to complete 
controller box assembly

1. Install a 2-pin female 
socket to the buzzer 
cable. Attach a double-
sided tape on the back of 
the buzzer.

2. Build a 4-pin I2C cable with a 4-pin JST female socket on one 
end and a 5-pin JST female socket on the other end, aligning the 
I2C signals. Insert the cable between the transducer board and the 
controller board as shown

3. Stick the buzzer on the 
controller board as shown 
with a double-sided tape 
and insert the socket into 
the 2-pin plug J9.PV-PN-324

PV-PN-310

PV-PN-310

Potentiometer 
to adjust buzzer 
volume, by 
turning screw 
clockwise or 
counter 
clockwise



August 28, 2020, slide 143 of 187

Documentation published describing hardware is licensed under the CERN-OHL-S v2. You may redistribute and modify this documentation under the terms of the CERN-OHL-S v2.

Controller box assembly – STEP 19: print labels and stick them to the control box
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Controller box assembly – STEP 20: basic tests for some of the control box components

1. DISPLAY TEST: From Arduino (1.8.12) sketch, 
navigate and select File->Examples->LiquidCrystal-
>HelloWorld example. Map the LCD interface pins for 
our Arduino as shown:
rs=13, en=12, d4=11, d5=10, d6=9, d7=8;

Verify and Upload the code. You should see “hello, 
world!’ on line 1 and a seconds counter on line 2 of the 
display. Note: If display is blank, please adjust the 
display contrast as shown in Step 17

2. SPEAKER TEST: From Arduino sketch, select File-
>Examples->Digital->toneMultiple example. Verify and 
Upload the code. You should hear a 200-ms ‘beep’ 
from the buzzer every second. 

3. BMP280 TESTS:. Download and use 
sSense_BMx280 library. From Arduino Sketch, select 
File->Examples->sSense_BMx280-
>sSense_BMx280_example. Search code for I2C 
Address setting. Use the default address 0x76 to test 
the ambient BMP280. Change address to 0x77 to test 
the airway BMP280. Open the Tools->Serial Monitor, 
set the baud rate to 19200. You should see valid Temp 
and Pressure values printed every second. Perform 
test for both sensors.

4. ALLSENSOR DLHR TEST: Download and use 
Allsensors DLHR library. Select File->AllSensors
DLHR->ReadSensor example. Verify and Upload the 
code. Open the Tools->Serial Monitor, set baud to 
115200. You should see valid Differential Pressure and 
Temperature printed every 100 ms.

5. LED TESTS: Connect only AC Supply to “PWR IN”, 
you should see Green LED lit. Connect only DC 12V 
battery, you should see Red LED lit.

NOTE: THESE TESTS ASSUME THAT THE USER HAS SOME FAMILIARITY WITH ARDUINO CODE DEVELOPMENT ENVIRONMENT AND HAS APPRORIATE LIBRARIES DOWNLOADED
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PV-PN-A14 – plastic enclosure full assembly – STEP 1: glue plenums to inside of box

PV-PN-A12

PV-PN-A11

PV-PN-A11

PV-PN-223
Ensure enough epoxy is used to fill 
the gap beneath the base of the 
plenums
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PV-PN-A14 – plastic enclosure full assembly – STEP 2: glue big plenum tubes together

PV-PN-218

PV-PN-246

Cut tubing to 3 inches 

Cut tubing to 1.4 
inches

PV-PN-224
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PV-PN-225

PV-PN-226

Cut tubing to 11.75 
inches 

Cut tubing to 13 
inches 

PV-PN-A14 – plastic enclosure full assembly – STEP 3: cut small plenum tubes
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A

B

C

A

B

C

PV-PN-A14 – plastic enclosure full assembly – STEP 4: connect tubes to respective sensors 
and plenums.

PV-PN-218

PV-PN-246

PV-PN-225

PV-PN-226
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A

B

C

PV-PN-A14 – plastic enclosure full assembly – STEP 5: carefully push small bits of tubing 
over the outer brass tube of big plenum.

PV-PN-247

Cut Qty: 2 bits of tubing to 0.4250 
inches 
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PV-PN-A14 – plastic enclosure full assembly – STEP 6: push larger tubing over the new 
piece of smaller tubing.

PV-PN-248

Cut tubing to 5.0 inches 
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PV-PN-224

PV-PN-A14 – plastic enclosure full assembly – STEP 7: add a bit of epoxy to the base of each 
of the plenums. 

Ensure epoxy glob goes up over the plastic 
tube.

Ensure epoxy glob goes up over the plastic 
tube.
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Use dimensions shown in permanent marker here.
- tip: start with small drill bit and work your way up 
to larger.  Or use a “step drill”.

PV-PN-A14 – plastic enclosure full assembly – STEP 8: drill holes in the box

PV-PN-242

NOTE: top is removed here.
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Use dimensions shown in permanent marker here.
- tip: start with small drill bit and work your way up 
to larger.  Or use a “step drill”.

PV-PN-A14 – plastic enclosure full assembly – STEP 9: drill more holes in the box
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Use dimensions shown in permanent marker here.
- tip: start with small drill bit and work your way up 
to larger.  Or use a “step drill”.

PV-PN-A14 – plastic enclosure full assembly – STEP 10: drill more holes in the box
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Use dimensions shown in permanent marker here.
- tip: start with small drill bit and work your way up 
to larger.  Or use a “step drill”.PV-PN-097

PV-PN-A14 – plastic enclosure full assembly – STEP 11: insert bulkhead push-to-connect

Note: PV-PN-268, PV-PN-269, and PV-PN-099 (NPT-to-male DISS) are needed to connect to a female DISS connector coming from an oxygen supply.
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PV-PN-244

PV-PN-A15

Snip ends of the zip ties off for a cleaner layout.

PV-PN-A14 – plastic enclosure full assembly – STEP 12: zip tie in the solenoid wiring 
harness.
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PV-PN-A14 – plastic enclosure full assembly – STEP 13: install regulator and plug in tube.

PV-PN-007

PV-PN-A06

In subassembly:

Push tubing from regulator into the connection on the 
tub

PV-PN-096
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PV-PN-244

PV-PN-A14 – plastic enclosure full assembly – STEP 14: add zip ties to assembly.
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PV-PN-A14 – plastic enclosure full assembly – STEP 15: add the inspiratory limb to the assembly.

PV-PN-A03
Push outlet through the hole in the tub first. 
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PV-PN-A14 – plastic enclosure full assembly – STEP 16: place optional supportive foam in behind valve.

PV-PN-249

= support foam could be better.  Something a little more supportive and conforming would be good.

Ensure the Orbit valve rests in the VERTICAL 
orientation.
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PV-PN-A14 – plastic enclosure full assembly – STEP 17: plug tube into regulator.

PV-PN-016
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PV-PN-A14 – plastic enclosure full assembly – STEP 18: plug tube into valve block

PV-PN-231
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PV-PN-A14 – plastic enclosure full assembly – STEP 19: add supportive zip ties to corner

PV-PN-244
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PV-PN-A02

PV-PN-A14 – plastic enclosure full assembly – STEP 20: add expiratory arm to assembly

Note that the flow meter assembly is not installed yet Put the CPVC tube in first Secure with zip ties.
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PV-PN-A14 – plastic enclosure full assembly – STEP 21: plug in tube to valve block
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PV-PN-252

PV-PN-251

PV-PN-250

PV-PN-A14 – plastic enclosure full assembly – STEP 22: size and cut flow meter connection 
tubes.

adapter

downstream
upstream
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PV-PN-251

PV-PN-250

PV-PN-224

PV-PN-A14 – plastic enclosure full assembly – STEP 23: glue adapter tube to the 
downstream tube
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PV-PN-252

PV-PN-251
PV-PN-250

PV-PN-A14 – plastic enclosure full assembly – STEP 24: push plastic tubes onto the brass 
tubes.

adapterdownstream

upstream

Triple check the end of the 
brass tubes is still in the 
middle of the PVC pipe.

Be very gentle or you might 
push the brass tube in too far.

Be very gentle or you might 
push the brass tube in too far.
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PV-PN-A10

PV-PN-229

PV-PN-A14 – plastic enclosure full assembly – STEP 25: add the flow meter assembly to the main 
assembly. 
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PV-PN-A14 – plastic enclosure full assembly – STEP 26: connect the harness to the 
inspiratory valve.
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PV-PN-A14 – plastic enclosure full assembly – STEP 27: preinstall the hardware to attach 
controller box.

PV-PN-255

PV-PN-256

PV-PN-257
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PV-PN-A14 – plastic enclosure full assembly – STEP 28: place bottom of controller box in 
tub.

PV-PN-209
Tighten from bottom of tub.

PV-PN-A13(part of                            )
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PV-PN-A14 – plastic enclosure full assembly – STEP 29: secure battery in the bottom of the 
controller box.

PV-PN-223

or
Connect the battery wires from the 
top of the controller box to the 
battery before closing the thing up.

PV-PN-A13

PV-PN-299
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PV-PN-A14 – plastic enclosure full assembly – STEP 30: screw down the top of the controller 
box.

These are included with the box

PV-PN-209
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PV-PN-A14 – plastic enclosure full assembly – STEP 31: connect the flow meter tubes to the 
box

Upstream  “Out”

downstream  “Pt”
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PV-PN-A14 – plastic enclosure full assembly – STEP 32: connect solenoid wiring harness to 
controller box.

Sometimes it take a push to get the plug 
to go in.  Screw down ring to secure. 
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PV-PN-A14 – plastic enclosure full assembly – STEP 33: create jig and window using acrylic. 

PV-PN-243

PV-PN-T202
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PV-PN-A14 – plastic enclosure full assembly – STEP 34: drill hole in tub top
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PV-PN-A14 – plastic enclosure full assembly – STEP 35: Apply silicone adhesive and bolt 
window down.

PV-PN-229

PV-PN-258

PV-PN-259
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PV-PN-A14 – plastic enclosure full assembly – STEP 36: apply adhesive around the window 
to seal it.

PV-PN-229
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PV-PN-A14 – plastic enclosure full assembly – STEP 37: apply sealing tape over the holes in 
the box.

PV-PN-245
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PV-PN-A14 – plastic enclosure full assembly – STEP 38: add silicone adhesive around 
protruding tubes

PV-PN-229
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PV-PN-A14 – plastic enclosure full assembly – STEP 39: add power supply and cable

PV-PN-254

PV-PN-253

FEED POWER SUPPLY CABLE 
THROUGH THIS HOLE.  I 
THINK A SECOND HOLE WILL 
BE NEEDED TO ZIP TIE THIS 
IN PLACE.
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COMPLETED ASSEMBLY!


